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1 Disclaimers and License
By using DirSync Pro you confrm that you have read and accepted the disclaimers and
the license terms.

1.1 Disclaimer of Warranty
DirSyncPro IS DISTRIBUTED IN THE HOPE THAT IT WILL BE USEFUL, BUT WITHOUT
ANY WARRANTY; THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. THE COPYRIGHT HOLDERS PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.

1.2 License
DirSyncPro is free software: you can redistribute it and/or modify it under the terms of the
GNU General Public License as published by the Free Software Foundation, either version
3 of the License, or (at your option) any later version. The fle GPL.txt which is provided
along with DirSync Pro, contains a copy of the GNU General Public License. If you could
not fnd this fle, see http://www.gnu.org/licenses/.
The icons used in DirSync Pro are from the Kommon Desktop Environment KDE
(www.kde.org) released under the GPL.

1.3 Disclaimer of 'Check for updates'
By default (every new version of) DirSync Pro checks for program updates as soon as the
program is started (and the license is accepted). Except in the unstable versions, you may
disable checking for updates in the Options menu (Tools > Options). When checking for
updates, DirSync Pro will send ONLY the current program alphanumeric version indication
(for example '1.51' or '1.51b1') to the update server to verify if a newer version is released.
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2 What is DirSync Pro?
DirSync Pro is a small, but powerful utility for fle and folder synchronization. DirSync Pro
can be used to synchronize the content of one or many folders recursively. Use DirSync
Pro to easily synchronize fles from your desktop PC to your USB-stick (/Externa
HD/PDA/Notebook, ...). Use this USB-stick (/Externa HD/PDA/Notebook, ...) to
synchronize fles to another desktop PC.
Using DirSync Pro you can make incremental backups. In this way you'll spare lots of time
because you don't have to copy all the fles each time you want to update your backup;
only new/modifed/larger fles would be copied. DirSync Pro provides some preconfgured
modes (e.g. Mirror, Backup, Contribute, …) for common synchronization and backup tasks
and some custom modes in which the user could set up the synchronization behavior to
meet specifc wishes. Prior to synchronization, DirSync Pro perfoms an analysis on fles
and folders and detect any kind of changes to any fle/directory in the source. If a fle is for
example modifed, removed, deleted, renamed in the source DirSync Pro synchronizes the
destination accordingly. DirSync Pro detects also changes to fle meta data (e.g. DOS
attributes, POSIX fle ownerships/group/permissions) and could preserve them to the
destination fle/directories.
DirSync Pro has a user-friendly User Interface which helps you confgure many options to
your needs. You can use DirSync Pro also through the command line which makes it very
fexible for running in batches.
DirSync Pro lets you defne advanced flters based of flename patterns (textual and
regular expression based), fle sizes, modifcation dates, fle paths and fle meta data to
include or exclude fle/directories as desired.
DirSync Pro has a powerful schedule engine which lets you schedule synchronization
tasks on many different ways, minutely, hourly, daily, weekly and monthly. Advanced users
may use tons of options available in DirSync Pro to suit the synchronization behavior in
details. DirSync Pro has many logging facilities which let you create detailed logs even per
job.
DirSync Pro provides a real-time synchronization option which watches the source
directory continuously and synchronizes the changes into the destination directory if a
fle/directory is changed.
Unlike many other synchronization software, DirSync Pro is Open Source; it is 100% free
of charge, 100% free of commercial text, 100% free of advertisements and 100% free of
spyware. You can use it as long as you like, without any limitations in time or funcationality.
You can freely distribute it according to GPL3.
DirSync Pro is programmed completely in platform independent Java™ so it can be run
under nearly every modern operating system including Windows™, Linux™ and
Macintosh™.

3 User Interface
Synchronize can be confgured via a GUI. You can use the GUI to execute a
synchronization, or you can use the GUI to create a jobset fle and run the synchronization
in console mode.
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3.1 Menu and Toolbar

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

14.
15.
16.
17.

Create a New jobset.
Open an existing jobset.
Open Recently loaded jobsets.
Load and Append a saved jobset to the current one.
Save the current jobset.
Save the current jobset As a new fle.
Save the enabled jobs As a new fle.
Quit the program.
Start to Analyze the jobs. No synchronization will be carried out. The jobs should
always be analyzed before synchronization.
Start to Synchronize the jobs. If not analyzed yet, DirSync Pro will initiate
Analyze frst.
Pause analyzing/synchronizing. If a fle is being copied, the program pauses after
the copy process is carried out.
Stop analyzing/synchronizing. If a fle is being copied, the program stops after the
copy process is carried out.
Shut down the system after the synchronization is carried out. If you use this
command, DirSync Pro will opens a count-down dialog for 30 seconds after which
the system will shut down.

Start the Synchronization Engine.
Stop the Synchronization Engine.
Swap the paths of source and destination directories in all jobs.
Open the Generate command line window which lets you create a batch
command or batch fle to run DirSync Pro in a batch.
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18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.

Open the Options window.
Display Help contents for DirSync Pro.
Start the default internet browser and goes to the Donation page to Make a
Donation.
Check for program updates if available.
Display information About DirSync Pro.
New jobset short-cut.
Open jobset short-cut.
Save jobset short-cut.
Save jobset As short-cut.
Analyze short-cut.
Synchronize short-cut.
Pause Analyze/Synchronize short-cut.
Stop Analyze/Synchronize short-cut.
Start the Schedule Engine short-cut.
Shut down the system after the synchronization is carried out.
Stop the Schedule Engine short-cut.
About short-cut.
Help contents short-cut.
Make a Donation short-cut.
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3.2 Main Window
3.2.1

1.
2.
3.
4.
5.
6.
7.

Job Tree

The Jobs tab: shows the confgured jobs in a visual tree.
The Job tree: shows the details of the confgured jobs.
Enable/Disable check box: to enable or disable a job for synchronization. Only
the enabled directories get synchronized.
Add a new job to the tree.
Edit the selected job. This opens the Job Edit dialog for the selected job.
Move the selected job Up. The jobs are synchronized from top to down. Upper
jobs get synchronized frst.
Move the selected job Down. The jobs are synchronized from top to down.
Upper jobs get synchronized frst.
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8.
9.
10.
11.
12.

Copy the selected job.
Remove the selected job.
Enable All jobs.
Disable all jobs (None enabled).
Expand the job tree one level. This opens up the tree for one level. Clicking it
once more, will expand the tree another level.
13. Collapse the job tree.
14. The Total progress of the overall synchronization. During the synchronization this
bar shows also the elapsed and remaining time.
15. The progress of the synchronization of the Current item. During the analyze
process, this bar shows the steps being carried out. During the synchronization
this bar shows also the name of the fle/directory being synchronized.
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3.2.2

Synchronization queue

3.2.2.1 Synchronization queue: Summary tab

1.
2.

3.
4.
5.
6.
7.
8.
9.

The Sync Queue tab: shows the synchronization queue. You'll see here all the
fles which are going to be synchronized.
The Summary tab: shows some statistics about the synchronization:
number/size of Analyzed fles/directories, number/size of fles/directories to be
synchronized, number/size of New fles/directories, number/size of Modifed
fles, number/size of Larger fles, number/size of fles which are Larger and
modifed and number/size of fles/directories to be deleted.
The statistics of the current synchronization.
The number of Analyzed fles/directories.
The number of fles/directories To be Synchronized.
The number of fles/directories To be copied Always.
The number of New fles/directories.
The number of Modifed fles/directories.
The number of Larger fles.
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10.
11.
12.
13.

The number of Larger AND modifed fles.
The number of fles/directories To be Deleted.
The number of fles/directories which are involved in a synchronization confict.
The Synchronization Queue list which shows the fle names, modifcation
dates and sizes of the fles in Directory A and Directory B.
By right clicking a record in the synchronization queue, you get a context-aware
menu with which you may manipulate the synchronization queue.

3.2.2.2 Synchronization queue: View tab

1.

2.
3.
4.
5.

The View tab: allows fltering the view of the synchronization. This flter does not
affect the synchronization queue. It only affects fles/directories currently being
shown.
Show New fles/dirs.
Show Modifed fles.
Show Larger fles.
Show Larger & Modifed fles.
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6.
7.
8.
9.
10.

Show Files to be deleted.
Show Dirs to be deleted.
Show Conflict items
Reset the view flters.
Apply (OK) the flters.

3.2.2.3 Synchronization queue: Filter tab

1. The Filter tab: allows fltering the synchronization queue. This helps you to make a
selection of fles to be synchronized. This flter does affect the synchronization
queue. Only the fles that remain in the queue are synchronized during the
synchronization process.
2. Show New fles/dirs.
3. Show Modifed fles.
4. Show Larger fles.
5. Show Larger & Modifed fles.
6. Show Files to be deleted.
7. Show Dirs to be deleted.
8. Reset the view flters.
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9. Show Conflict items
10. Apply (OK) the flters.
3.2.2.4 Right mouse click context menu

If you right mouse click an entry in the synchronization queue, a context menu appears in
which you always may:
1. Remove this entry from the synchronization queue (not from the fle system). This
means that the corresponding fle pair will not be synchronized.
2. Remove all of this mode from the synchronization queue, which means all the
entry of which the synchronization mode is the same as the selected entry, will be
removed from the synchronization queue (not from the fle system) and so will not
be synchronized.
3. Remove all selected from the synchronization queue, which means all selected
(highlighted) entries will be removed from the synchronization queue (not from the
fle system) and so will not be synchronized. In the synchronization queue you may
select multiple entries using the CTRL and/or SHIFT key in combination with left
mouse click.
Additionally, depending on which column you right click, some other options will appear.
If you right click on the name of a folder or a fle, you may:
4. Open the fle/directory in the system fle explorer. If the fle is associated with an
application, the fle is then opened in the regarding application.
5. Open the parent folder of a fle in the system fle explorer.
If you right click on the name/date/size of a fle/directory, you’ll get a submenu:
14. Add Exclude Filter with which you may quickly add a context-aware flter. The flter
dialog will then open automatically in which you may fne-tune the flter.
This context-aware flter holds various options based on the data of the selected
fle/directory. If you right click the name of a fle/directory, you may:
7. Add a Pattern flter based on the name of the fle/directory. After the flter dialog has
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appeared, you may fne-tune the pattern manually.
8. Add a Pattern based on the fle Extension. Again, you may fne-tune the flter in the
flter dialog which opens automatically.
If you right click on the modifcation date of a fle, the context-aware Add Exclude Filter
lets you:
9. Add a date flter for fles having earlier (<) modifcation date than the selected fle
size.
10. Add a date flter for fles having exactly same (=) modifcation date as the selected
fle size.
11. Add a date flter for fles having later (>) modifcation date than the selected fle size.
If you right click on the fle size of a fle, the context-aware Add Exclude Filter lets you:
12. Add a fle size flter for fles having smaller (<) size than the selected fle size.
13. Add a fle size flter for fles having exactly same (=) size as the selected fle size.
14. Add a fle size flter for fles having larger (>) size than the selected fle size.
If you right click on the synchronization mode, you’ll get two submenu’s:
15. Change to: which lets you change the mode of the selected synchronization item to
another mode.
16. Change all of this mode to: which lets you change the mode of all the
synchronization items with the same mode to another mode.
17. Change all selected to: which lets you change the mode of all the selected items
to another mode.
Depending on the context, you may change the mode to:
18. Forced Copy File/Dir A
19. Forced Copy File/Dir B
20. File/Dir B is Redundant
21. File/Dir A is Redundant
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3.2.3

Schedule queue

1. The Schedule tab: shows the scheduled synchronization tasks.
2. Schedule Engine Status line shows whether the synchronization engine is
Running or Not.
3. The schedule table shows all the scheduled tasks. For each task the following
information is shown:
1. Type of the scheduled task (Once, Minutely, Hourly, Daily, Weekly and Monthly).
2. The job the scheduled task belong to.
3. The next following event (date/time) when the scheduled is being run.
4. Details of the scheduled task.
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3.2.4

Messages

1. The Messages tab: shows the messages being created during the analysis and
synchronization process.
2. Allows fltering the Info messages.
3. Allows fltering the Warning messages.
4. Allows fltering the Error messages.
5. Allows fltering the File operations.
6. Reset the view flters.
7. Apply (OK) the flters.
8. Clean the Messages list.
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3.3 Job options
3.3.1

Basic options

1. The Basics tab: shows basic confguration of the job.
2. The Label of this job. The label is the name of the job. It is also used when to
create the default log flename for this job.
3. The path to Dir A for this job. Here you specify the directory with the original fles,
also known as the source directory. You can specify here the following (case
sensitive) wildcards:
<username> for the name of the current user, and
<userhome> for the home directory of the current user.
You may drag a directory into this feld which causes its absolute path to be
copied into this feld.
4. Browse for Dir A directory. Important Note: The Java Run-time Environment (JRE)
which ships in recent Mac OSX's (like Lion) limits unfortunately the users access
to other fles/folders other than his/her personal fles/folders. This limitation affects
all Java applications (including DirSync Pro) which means no Java application can
go beyond your personal fles. We have no idea why Apple enforces this limitation
to JRE for Mac users. The only way to eliminate this limitation is to install and use
the original JRE from Sun/Oracle.
5. The path to Dir B for this job. Here you specify the directory which will be
synchronized according to Dir A. This directory is also known as the destination
directory. You can specify here the following (case sensitive) wildcards:
<date> for the current date, and
<DD> for the current day,
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6.
7.
8.

9.

<MM> for the current month,
<YYYY> for the current year.
<time> for the current time, and
<hh> for the current hour,
<mm> for the current minute,
<ss> for the current second.
<username> for the name of the current user, and
<userhome> for the home directory of the current user.
You may drag a directory into this feld which causes its absolute path to be
copied into this feld.
Browse for Dir B directory.
Swap Dir A and Dir B.
Includes subfolders in this synchronization. Here you can decide whether you
want to synchronize the content of the source directory including subfolders or
not.
Synchronization Mode pull down. This pull down allows you to select pre-defned
synchronization confgurations or to defne your own custom confguration. The
options are:
• Mirror A -> B (incremental): This is a mono-directional (one way)
preconfgured synchronization which copies all the new and modifed
fles/directories from DirA to DirB. A fle/directory in DirB which does not
correspond to a fle/directory in DirA is marked as redundant and will be
deleted. DirB is exactly the same as DirA after the synchronization.
• Mirror B -> A (incremental): Same as 'Mirror A -> B (incremental)' with DirA
and DirB swapped.
• Synchronize A <-> B (incremental): This is a bi-directional (two way)
preconfgured synchronization which copies all the new and modifed
fles/directories from DirA to DirB and from DirB to DirA. All redundant fles in
DirA/DirB (according to each other) will be deleted after the synchronization.
DirA and DirB will be exactly the same after the synchronization. If you select
this mode, you may also defne the confict resolution mode in the confict
resolution tab.
• Synchronize A <-> B (custom): Same as ‘Synchronize A <-> B
(incremental)’ except some tabs get enabled in which you may set up your
own options to defne the synchronization behavior as you may wish.
• Backup A -> B (full): This is a full copy preconfgured synchronization which
will copy all fles/directories one-by-one from DirA to DirB. This mode is
useful when you want to make a complete back up of DirA.
• Restore B -> A (full): This is a full copy preconfgured synchronization which
will copy all fles/directories one-by-one from DirB to DirA. This mode is
useful when you want to restore a backup to DirA.
• Contribute A -> B (incremental): This is a mono-directional (one way)
preconfgured synchronization which copies all the new fles/directories from
DirA to DirB. No fle is deleted from DirB in this mode.
• Contribute B -> A (incremental): Same as 'Contribyte A -> B (incremental)'.
with DirA and DirB swapped.
• Synchronize A -> B (custom): This is a mono-directional (one way) custom
synchronization from DirA to DirB. If you select this mode, some tabs get
enabled in which you may set up your own options to defne the
synchronization behavior as you may wish.
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Synchronize A -> B (custom): Same as 'Synchronize A -> B (custom)' with
DirA and DirB swapped.
• Context Information about this tab.
10. OK button to save all the settings to the job.
11. Cancel button to ignore all changes.
12. Context Information about this tab.
•

Important note: Some tabs get only available only in a custom synchronization mode.
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3.3.2

Compare options

1. The Compare tab in which compare options are set.
2. Compare fle sizes and modifcation dates. With this option, the fle gets copied:
1. when the fle in Dir A is modifed later than the fle in Dir B (in case of
New/Modifed copy options), or:
2. when the fle is Dir A is larger than the fle in Dir B (in case of Larger copy
option).
3. Compare fle sizes, modifcation dates and meta data (attributes, permissions,
ownerships): With this option, the conditions from the previous option apply, plus
that the fle meta data is taken into account. The fle will get copied if the
modifcation data is changed (New/Modifed copy option), fle size is larger (Larger
copy option) or attributes/POSIX permissions/POSIX ownerships are changed.
4. Compare fle contents: with this option, the fle contents will be compared byte by
byte if the fle sizes are the same. If fle sizes differ, a sync confict will occur.
Please note that comparing fle contents is a very time consuming task.
5. Context Information about this tab.
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3.3.3

Copy options

1. The Copy tab in which copy options are set.
2. Copies All fles and directories. If a fle already exists in the destination directory it
will always be overwritten with that one from the source directory. If you specify this
option, all other copy options will be ignored.
3. Copies only New (not existing in destination directory) fles and directories. Files
that exist in the source directory but not in the destination directory will be copied to
the destination directory.
4. Copies only Larger fles and directories. If there already is a fle with the same
name in the destination directory, it will only be overwritten with the fle from the
source directory if its size is smaller than the size of the original fle in the source
directory.
5. Copies only Modifed fles and directories. If there already is a fle with the same
name in the destination directory, it will only be overwritten with the fle from the
source directory if its modifed-date is older than the modifed-date of the original fle
in the source directory.
6. Copies only Larger AND Modifed fles and directories. If there already is a fle with
the same name in the destination directory, it will only be overwritten with the fle
from the source directory if its size is smaller and its modifed-date is older than the
size and date of the original fle in the source directory. If you specify the option
'Copy larger' or 'Copy modifed', this option will be ignored (you already copied this
fles).
7. Context Information about this tab.
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3.3.4

Conflict Resolution options

3.3.4.1 Mono-directional sync confict resolution

1. The Conflict Resolution tab: shows options when conficts happens while using a
mono-directional or bi-directional synchronization. You may set these options only if
the Sync Mode is set to bi-directional or a custom mode.
2. Mono-directional confict resolution tab.
1. Mono-directional sync confict resolution through Overwriting the fle in
destination with the fle from the source: when synchronizing from monodirectional in a custom mode, if the fle in destination is modifed later (fle is newer),
the fle from the source is copied over the fle in destination; the fle in destination
will be overwritten.
2. No Mono-directional sync confict resolution Do nothing. Just warn me: when
synchronizing from mono-directional in a custom mode, if the fle in destination is
modifed later (fle is newer), nothing will be copied. Instead the user gets a warning
and could fx the confict manually.
3. No Mono-directional sync confict resolution Do nothing. Just skip silently: when
synchronizing from mono-directional in a custom mode, if the fle in destination is
modifed later (fle is newer), the fle will be skipped silently.
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3.3.4.2 Bi-directional sync confict resolution

1. The Conflict Resolution tab: shows options when conficts happens while using a
mono-directional or bi-directional synchronization. You may set these options only if
the Sync Mode is set to bi-directional or a custom mode.
2. Bi-directional confict resolution tab.
3. Bidirectional sync confict resolution through Copying the latest modifed fle to
both directories: when synchronizing bidirectionally, if two fles are modifed in
both directories individually, the latest modifed fle will be copied to both directories.
4. Bidirectional sync confict resolution through copying the largest fle to both
directories: when synchronizing bidirectionally, if two fles are modifed in both
directories individually, the largest fle will be copied to both directories.
5. Bidirectional sync confict resolution through renaming copying both fles to both
directories: when synchronizing bidirectionally, if two fles are modifed in both
directories individually, they are postfxed (renamed with added extensions .DirA
and .DirB) and they both will be copied to both directories.
6. No Bidirectional sync confict resolution Do nothing. Just warn me: when
synchronizing bidirectionally, if two fles are modifed in both directories individually,
none of the fles are copied. Instead the user gets a warning and could fx the
confict manually.
7. No Bi-directional sync confict resolution Do nothing. Just skip silently: when
synchronizing bidirectionally, if two fles are modifed in both directories individually,
the fles will be skipped silently.
8. Context Information about this tab.
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3.3.5

Filters options

1. The Filters tab to defne which fles/directories should be included/excluded. You
may redefne these options if the Sync Mode is set to custom.
2. Filters Tree gives an overview of all flters for this job in a tree structure.
3. Add a New flter.
4. Edit an existing flter. This button is enabled only if a flter in the flter tree is
selected.
5. Remove an existing flter. This button is enabled only if a flter in the flter tree is
selected.
6. Expand the flter tree one level. This opens up the tree for one level. Clicking it
once more, will expand the tree another level.
7. Collapse the flter tree.
8. Context Information about this tab.
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3.3.5.1 Adding/Editing a flter: Basics tab

1. The Basics tab to defne the the type of the flter and whether to include/exclude
items.
2. Select here whether to Include or Exclude the matched fles or directories.
3. Include the matched fles or directories.
4. Exclude the matched fles or directories.
5. Select here the Filter type. One of the tabs By Pattern and By Size will get enabled
according to the selected flter type.
6. Filter based on File/dir pattern. This flter affects fles and directories of which the
name matches a text pattern.
7. Filter based on File Size. This flter affects fles of which the size satisfy some
conditions.
8. Filter based on File Date. This flter affects fles of which the modifcation date
satisfy some conditions.
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9. Filter based on Path. This flter affects fles/directories of which the absolute path is
exactly the same as defned.
10. Filter based on File attributes. This flter affects fles having one or more specifc
DOS attributes and may be defned only under MS Windows/DOS.
11. Filter based on File ownership. This flter affect fles/directories having a specifed
owner or group and may be defned only under Posix systems (Linux, Unix, …).
12. Filter based on File Permissions. This flter affect fles/directories having a
specifed fle permission and may be defned only under Posix systems (Linux,
Unix, …).
13. Context Information about this tab.
14. OK button to save all the flters.
15. Cancel button to ignore all changes.
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3.3.5.2 Adding/Editing a flter: By Pattern tab

1. The By Pattern tab to defne a pattern to match the name of the fles or directories.
2. Defne here the Pattern for the fle/directory name. Only fles/directories matching a
specifed pattern should be included or excluded. For example if you specify
'*.txt' only fles/directories that end with '.txt' will be processed; or if you specify
'*_new', only fles/directories that end with '_new' will be processed. You can use
wildcards (i.e. '?' and '*'). '?' means zero, or one character, '*' means zero, one, or
more characters. If you wish to enter many patterns, you may enter them here. You
may enter multiple patterns by separating them using semi-column (‘;’) character,
like ‘*.gif;*.jpg;*.png’. When you click on OK, multiple patterns will be parsed and
split into individual pattern flters.
3. Pattern is a File pattern.
4. Pattern is a Directory pattern.
5. When this option is selected, the pattern is interpreted as a regular expression.
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6. Context Information about this tab.
3.3.5.3 Adding/Editing a flter: By File Size tab

1.
2.
3.
4.
5.
6.

The By File Size tab to defne flters based on fle sizes.
Match fles Smaller than.
Match fles Exaclty with the size.
Match fles Larger than.
The File size in bytes.
Context Information about this tab.
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3.3.5.4 Adding/Editing a flter: By File Date tab

1.
2.
3.
4.
5.
6.
7.

8.
9.

The By File Date tab to defne flters based on fle dates.
Match fles Earlier than.
Match fles Exaclty on a date.
Match fles Later than.
Set this flter based on a Specifc Time. In this case the specifed time will be used
to compare to the modifcation time.
The specifc Time formatted as dd-MM-yyyy HH:mm.
Set this flter based on number of some Time unit. In this case the modifcation
time is relatively compared to ‘now’, according to the number of specifed time unit
(like: ‘10 days ago’).
Number of time units to be specifed.
The Time unit to be specifed; available options are: Hours, Days, Weeks,
Months.
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10. Context Information about this tab.
3.3.5.5 Adding/Editing a flter: By Path tab

1.
2.
3.
4.

The By Path tab to defne flters based on the fle/directory path.
The Path to the fle/directory.
Browse button to select a fle/directory.
Context Information about this tab.
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3.3.5.6 Adding/Editing a flter: By Attribute tab

1.
2.
3.
4.
5.
6.

The By File Attribute tab to defne flters based on DOS attributes of the fle.
Match fles with the Read only.
Match fles with the Hidden attribute.
Match fles with the System attribute.
Match fles with the Archive attribute.
Context Information about this tab.

This flter could only be defned on MS Windows/DOS systems.
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3.3.5.7 Adding/Editing a flter: By Ownership tab

1. The By File Ownership tab to defne flters based on Posix ownerships of the
fle/directory.
2. Match fles/directories with the specifed Owner.
3. Match fles/directories with the specifed Group.
4. Context Information about this tab.
This flter could only be defned on Posix systems (Linux/Unix, ...).
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3.3.5.8 Adding/Editing a flter: By Permission tab

1. The By File Ownership tab to defne flters based on Posix permissions of the
fle/directory.
2. Match fles/directories with the specifed bit-wise permissions. Once you edit these
check-boxes, the Numeric value will be calculated and updated automatically in the
corresponding feld.
3. Match fles/directories with the specifed Numeric permission. Once you edit this
value, the bit-wise permissions will be calculated and updated automatically in the
corresponding check-boxes.
4. Context Information about this tab.
This flter could only be defned on Posix systems (Linux/Unix, ...).
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3.3.6

Deletion options

1. The Deletion tab to defne the deletion behavior after the synchronization. You may
redefne these options if the Sync Mode is set to custom.
2. Delete fles not existing in the source directory from the destination directory. Files
that have been deleted in the source directory, but still exist in the destination
directory will be deleted in the destination directory.
3. Delete directories not existing in the source directory from the destination
directory. Directories that have been deleted in the source directory, but still exist in
the destination directory will be deleted in the destination directory.
4. Delete Excluded Files from Dir A. When this option is selected all fles which
match the Excluded Files pattern will be cleaned up (deleted) from Dir A.
5. Delete Excluded Directories from Dir A. When this option is selected all fles
which match the Excluded Directories pattern will be cleaned up (deleted) from Dir
A.
6. Delete Excluded Files from Dir B. When this option is selected all fles which
match the Excluded Files pattern will be cleaned up (deleted) from Dir A.
7. Delete Excluded Directories from Dir B. When this option is selected all fles
which match the Excluded Directories pattern will be cleaned up (deleted) from Dir
A.
8. Context Information about this tab.
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3.3.7

Backup options

1. The Backup tab to defne the backup behavior during the synchronization. You may
redefne these options if the Sync Mode is set to custom.
2. Keep n backups: Before a fle in the destination directory will be overwritten or
deleted the fle is copied to a special subdirectory of the destination directory as a
backup.
3. Keep the backup dir within the destination directory. If this option is not
selected, an alternative backup folder could be specifed.
4. Alternative Backup directory in which the backup fles will be created.
5. Browse for the alternative Backup directory.
6. Context Information about this tab.
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3.3.8

Logging options

1. The Log tab to defne the logging behavior after the synchronization.
2. Enable or disable separate logging for this job.
3. The Logfle. Normally the name of the job (label) is used to create the initial
flename for the log. You may also specify a custom flename. New log entries are
appended to the existing logfles and hence they will not be overwritten.
You can specify here the following (case sensitive) wildcards:
<date> for the current date, and
<DD> for the current day,
<MM> for the current month,
<YYYY> for the current year.
<time> for the current time, and
<hh> for the current hour,
<mm> for the current minute,
<ss> for the current second.
<username> for the name of the current user, and
<userhome> for the home directory of the current user.
4. Browse for the logfle or directory.
5. Context Information about this tab.
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3.3.9

Schedule options

1. The Schedules tab to defne schedules for this job. Schedules cause this job to
synchronize automatically on a certain time or recurrently according to a pattern.
2. Schedule Tree gives an overview of all schedules for this job in a tree structure. If a
schedule task of type Once has already run or if a recurrent schedule task does not
have a valid next event date due to its constraints, the schedule gets suffxed with
'(Expired)' in the schedule tree.
3. Add a New schedule.
4. Edit an existing schedule. This button is enabled only if a schedule in the schedule
tree is selected.
5. Remove an existing schedule. This button is enabled only if a schedule in the
schedule tree is selected.
6. Expand the schedule tree one level. This opens up the tree for one level. Clicking it
once more, will expand the tree another level.
7. Collapse the schedule tree.
8. Context Information about this tab.
Please note: After defning a Schedule job, you need to start the Schedule Engine in the
Main Window and Dirsync Pro program should keep running (but may be minimized).
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3.3.9.1 Adding/Editing a schedule: Basics tab

1.The Basics tab to defne the the type of the schedule and some general settings.
2.Select here the Schedule type. There are 6 types are schedules available.
3.Once: This schedule runs only once on a certain date/time.
4.Minutely: This schedule runs recurrently every X minutes.
5.Hourly: This schedule runs recurrently every X hours.
6.Daily: This schedule runs recurrently on a certain time daily.
7.Weekly: This schedule runs recurrently on a certain time and in specifc months
every X weeks.
8.Monthly: This schedule runs recurrently every month on day number X, on a
certain time and in specifc months.
9.Defne here if the task should run only during a time frame (From … To).
10. Enable Time frame From constraint.
11. Time frame From date value. If defned, the task will run only if its next event
date is after this date.
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12. Enable Time frame To constraint.
13. Time frame To date value. If defned, the task will run only if its next event date
is after this date.
14. Context Information about this tab.
15. OK button to save all the flters.
16. Cancel button to ignore all changes.
3.3.9.2 Adding/Editing a schedule: Schedule Once

1. The Schedule Once tab in which you may defne a task which runs once on a
certain time. If a Once schedule is not run, e.g. because other tasks are running all
the time, it will be queued for execution and will run later again. A Once schedule
which is older than 24 hours, will not run anymore.
2. The Time on which this schedule will run.
3. Context Information about this tab.
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3.3.9.3 Adding/Editing a schedule: Schedule Minutely

1. The Schedule Minutely tab in which you may defne a task which runs recurrently
every X minutes. The frst occurrence will get scheduled for 'now'.
2. The interval in minutes.
3. Context Information about this tab.
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3.3.9.4 Adding/Editing a schedule: Schedule Hourly

1. The Schedule Hourly tab in which you may defne a task which runs recurrently
every X hours. The frst occurrence will get scheduled for the next complete hours
(01:00, 02:00, 03:00, …).
2. The interval in hours.
3. Context Information about this tab.
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3.3.9.5 Adding/Editing a schedule: Schedule Daily

1. The Schedule Daily tab in which you may defne a task which runs recurrently
every X days on a certain time.
2. The interval in days.
3. The time of the day on which this task should run.
4. Context Information about this tab.
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3.3.9.6 Adding/Editing a schedule: Schedule Weekly

1. The Schedule Weekly tab in which you may defne a task which runs recurrently
every X weeks on a certain time and on specifc weekdays.
2. The interval in weeks.
3. The time of the day on which this task should run.
4. Checkboxes to select on which weekdays this schedule task should run.
5. Context Information about this tab.
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3.3.9.7 Adding/Editing a schedule: Schedule Monthly

1. The Schedule Monthly tab in which you may defne a task which runs recurrently
every month on day number X, on a certain time and in specifc months.
2. The Xth day of the month.
3. The time of the day on which this task should run.
4. Checkboxes to select on which months this schedule task should run.
5. Context Information about this tab.
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3.3.10

Advanced options

1. The Advanced tab to defne advanced options.
2. Timestamp granularity is the tolerance in seconds when when comaring the
modifcation time of fles/folders. Normally the granularity should be zero but in
some cases the fle system fails to set the exact modifcation time, e.g. when using
a network drive or copying fles cross platforms. Two fles with modifcation dates
difference less than the granularity will be treated as 'not modifed'.
3. Ignore daylight saving granularity could be useful when synchronizing between
FAT and other fle systems. This option makes that two fles with modifcation time
difference exactly 1 hour are treated as equal.
4. Preserve timestamps of the directories makes that the timestamps of the
directories in destination get identical to that of the directories in the source. This
option maybe useful for MS Windows/DOS users.
5. Write timestamps back to source fles causes to write the time stamps of the
copied fles back to the source fles. Caution: use this if you really need to.
6. Real-time synchronization option could be used to watch a directory automatically
and continuously. If this option is set, DirSync Pro starts synchronizing after the
preset number of seconds is passed since the last change is detected.
7. This is the number of seconds to wait before the next round of real-time
synchronization is automatically started.
8. Synchronization on start causes an initial synchronization prior to monitoring the
real-time changes.
9. Verify the synchronized fles causes that after a fle has been copied checksums
of the source and destination fle are calculated and compared. If the checksums
don't match an "Verify error" will be reported. This option could be useful if the
destination media are not completely trusted.
10. Skip symbolic links causes that symbolic links are ignored while copying. Only
DirSync Pro Manual

Page 45/56

11.
12.

13.

14.

15.

16.

applies if the source fle system uses symbolic links (UNIX, Linux, Mac OSX).
Copy symbolic links causes that symbolic links are verbatim copied. This will
create symbolic links in the destination folder (UNIX, Linux, Mac OSX).
Preserve DOS attributes causes that the DOS fle attributes of the fles in
destination get identical to that of the fles in the source. This option maybe useful
for MS Windows/DOS users and could only be set under these systems.
Preserve fle permissions causes that the Posix permissions of the
fles/directories in destination get identical to that of the fles/directories in the
source. This option maybe useful for Posix users and could only be set under these
systems.
Preserve fle ownership causes that the Posix ownerships of the fles/directories in
destination get identical to that of the fles/directories in the source. This option
maybe useful for Posix users and could only be set under these systems.
Attempt to override read-only attribute in destination when copying/deleting
causes the copy/deletion process to ignore the read-only (MS-DOS) fag in the
destination.
Context Information about this tab.

Understanding timestamp related problems
Some fle systems do not store timestamps accurately (e.g. FAT) and it is possible that
problems with the option "Modifed" arise (e.g. FAT always forces the time stamp down to
even seconds; if you copy a fle with a source timestamp of "12:05:01" to FAT it will be
stored with a destination timestamp of "12:05:00". The next time you synchronize this fle
with the "Copy modifed" option it will be copied again because the source timestamp is
newer than the destination timestamp).
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3.3.11

Job Actions

1.
2.
3.
4.

The Actions tab to perform some actions on the job settings.
Copy all the job options (except the paths) to all jobs in the job tree.
Copy all the job options (except the paths) to enabled jobs in the job tree.
Reset all the job settings (except the paths) to initial default settings. This loads the
application defaults to your job.
5. Context Information about this tab.
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3.4 Generate command line tool

Using this tool you may let DirSync Pro create the command line for you. The command
line could be used to start DirSync Pro directly from the command line. You could also
write the command line to a batch fle to start a specifc synchronization directly.
This tool is smart enough to check the type of the operating system (MS Windows vs.
Linux-like systems and uses the corresponding option delimiter (/ or -), fle separator
character (\ or /) and fle and path conventions.
1. This option adds a /sync (Or -sync for Linux-like systems) options to the
command line causes DirSync Pro to start synchronizing right away.
2. This option adds a /analyze (Or -analyze for UNIX-like systems) options to the
command line which causes DirSync Pro to start analyzing right away.
3. This option adds /schedule (Or -schedule for UNIX-like systems) options to
the command line which causes DirSync Pro to start the schedule engine as soon
as the GUI is started.
4. This option adds a /nogui (Or -nogui for UNIX-like systems) options to the
command line which causes DirSync Pro to start no graphical user interface.
5. This option adds a /quit (Or -quit for UNIX-like systems) options to the
command line which causes DirSync Pro to quit right after the synchronization.
6. This option adds a /iconify (Or -iconify for UNIX-like systems) options to the
command line which causes DirSync Pro to minimize to the system tray upon startup.
7. The created command line.
8. Close the window without further actions.
9. Copy the created command line to the system clipboard. You may paste this
clipboard elsewhere.
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10.Save the created command line to a batch fle. After clicking this button, you will be
asked to provide a flename. The extension .cmd and .sh are used for the
batchfle on MS Windows systems and Linux-like systems respectively.

3.5 Application Options window
3.5.1

General options

1. The General tab to defne general application options.
2. Whether the jobset fles are saved in the program folder. In some cases it is useful
to defne another jobset path for example if you do not have write permissions in the
program folder.
3. The path to the directory in which the jobset fles reside. You can defne a path in
which you usually keep your saved jobset fles.
4. Browse for the jobset fles path.
5. If the Load last loaded jobset is set, DirSync Pro will load the jobset that was
loaded in the last session automatically upon start up.
6. If the Start the Schedule Engine upon start up is set, DirSync Pro runs the
Schedule Engine as soon as the program is started.
7. Check for DirSync Pro program updates every time at start-up. If an update is
available following window will show up and lets you go to the download page to
download the latest version.
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8. Check for DirSync Pro program updates Now. If an update is available following
window will show up and lets you go to the download page to download the latest
version.
9. OK with the changes and exit options window.
10. Cancel the changes and exit options window.
3.5.1.1 Update window

1. Information about the available update (version, links, …)
2. Go to download page starts the default internet browser and opens the DirSync
Pro update website.
3. Not Now will close this window without further actions.
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3.5.2

View options

1. The View tab to defne application view options.
2. Use System “Native Windows” look & feel: If you are using MS Windows or
MacOS, you can select to use your own native windows look & feel.
3. Use Java “Metal” look & feel.
4. If the Minimize to the system tray option is set, DirSync Pro will minimize to the
system tray when you minimize the application window. DirSync Pro is then still
running, but the application window is not visible anymore.
5. The option Use single click instead of double click defnes whether the main
application window should be restored by a single click or a double one on the
DirSync Pro system tray icon.
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3.5.3

Synchronization options

1. The Sync tab to defne application synchronization options.
2. If Keep the sync queue after synchronization is set, DirSync Pro will not clear
the synchronization queue when the synchronization is carried out. This option
could be helpful if you get warnings on some items during the synchronization and
you want to resynchronize those items. If you synchronize the remaining queue
again, only the items which have not been synchronized will be retried.
3. You may change here the Shut-down command which is being used to turn of the
system when all the synchronization jobs are carried out.
4. Default button sets the command back to the default value. The default shut-down
command is depending on which operating system you use (MS Windows/DOS or
Posix).
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3.5.4

Log options

1. he Log tab to defne logging settings.
2. Enable/disable global logging. If enabled, DirSync Pro writes all the individual
messages of all jobsets to a global log fle (DirSyncPro.log).
3. Enable/disable jobset logging. If enabled, DirSync Pro writes all the individual
messages of all jobs belonging to a jobset to the jobset log fle ([JOBSET].log or
custom name if defned in the job settings).
4. Whether the log fles (global log or individual logs) are saved in the program
folder. In some cases it is useful to defne another log path for example if you do
not have write permissions in the program folder.
5. The path to the directory in which the the log fles should be saved. Please see the
chapter 'Advanced features' for explanation on default values for this option.
6. Browse for the log fle path.
7. Use Minimal log level: only events, warnings and errors are logged.
8. Use Moderate log level: events, warnings, errors and fle names are logged.
9. Use Excessive log level: events, warnings, errors, fle names and confguration
data are logged.

3.6 Command Line
You can use the GUI to generate the command line or even save it to a batch fle. The
syntax of the command line is:
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Usage: 'dirsyncpro [-help] [-usage] [-sync ][-analyze] [-schedule]
[-quit] [-nogui] <jobset file>'
-help

Display help on homepage, contact, and license.

-usage

Displays this screen.

-sync

Starts a synchronization if a confguration fle is specifed.

-analyze Starts a analysis rather than a synchronization if a confguration fle is
specifed.
-schedule Starts the schedule engine as soon as the the GUI is started.
-iconify Minimizes the Gui to the tray (if available) on start-up.
-quit

Quits the program after the analyze or the synchronization.

-nogui

Start DirSync Pro in console mode and start synchronization (only useful if a
confguration fle is being specifed).
Command line options start with a slash "/" on Windows and with a minus "-" on all other
operating systems.
Examples:
Start in GUI mode:
dirsyncpro
Start synchronization in GUI mode and quit afterwards:
dirsyncpro -sync -quit <jobset file>
On Windows:
dirsyncpro /sync /quit <jobset file>
Start synchronization in command line mode:
dirsyncpro -nogui <jobset file>
On Windows:
dirsyncpro /nogui <jobset file>

3.7 Advanced features
3.7.1

Default directory for program settings

DirSync Pro saves its settings (dirsyncpro.properties) in the program folder by
default. If the program folder is not writable, DirSync Pro uses either the value of the
dirsyncpro.home system property, if defned, or XXX/.DirSyncPro in which XXX
stands for the user.home system property. You may defne the dirsyncpro.home
system property when running DirSync Pro. To do so you should use something like:
java -Xmx512M -Ddirsyncpro.home="D:\\" -jar dirsyncpro.jar
Characters like '\' must be escaped.

3.7.2

Default directory for saving logs

DirSync Pro saves the logs (if enabled) by default in the folder where the program settings
are saved (see Default directory for program settings). You can change this default
directory by defning a new default directory through the options window in the GUI.
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3.7.3

Default directory for saving confgurations

When you want to open a confguration or when you are about to save one, the fle
choosing dialog starts in the directory where the program settings are saved (see Default
directory for program settings). You can change this default directory by defning a new
default directory through the options window in the GUI.

3.7.4

Log behavior

DirSync Pro lets you create a log fle for the synchronization (confguration) and for each
individual Directory Profle. The log fle for the synchronization is by default enabled. You
may disable this log fle in the Default Settings tab, if you wish. The log fle name is initially
set to the Synchronization name (this is the fle name of your confguration). You may
change the log fle name or path in the same tab.
If a Directory Profle is set to default settings, it'll log into the Synchronization log, if the log
is enabled. If it is not set to default, it's log fle is disabled initially. You may enable the log
in the Directory Settings tab. The log fle name is initially set to the Directory Profle name.
You may change the log fle name or path in the same tab.

3.7.5

Schedule a synchronization

DirSync Pro has a powerful synchronization engine with lots of scheduling features. But if,
for whatever reason, these features aren't enough for your purpose, you may use existing
scheduling tools in your operating system (like cron in Linux and Windows Task
Scheduler in Microsoft Windows) to setup scheduled tasks to run a synchronization with
DirSync Pro. This is how you can do it:
1. Use DirSync Pro user interface to setup your synchronization.
2. Save your confguration fle.
3. Use the command line generator tool to create your command line with with /quit
and /sync en eventually /nogui options. Save this command line to a batch fle.
4. Use your system scheduler to run the created batch fle as you like.

3.7.6

Auto start in MS Windows

You may want DirSync Pro to start automatically when you plug a USB drive under MS
Windows. To do so, create a fle called autorun.inf with the following content:
[AutoRun]
ACTION=Backup
Open=java -jar dirsyncpro\dirsyncpro.jar JobsetFile.dsc
And in case you want it to quit right away after the synchronization:
[AutoRun]
ACTION=Backup
Open=java -jar dirsyncpro\dirsyncpro.jar JobsetFile.dsc /sync
/quit

In which the JobsetFile.dsc is your corresponding preconfgured and saved jobset
fle. Please note that you may need to adjust the command in front of Open= to suit the
paths in your system. You should use the command line generator tool (under Tools menu)
to create the right command for you.
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3.7.7

Allocating more memory for DirSync Pro

If you run DirSync Pro through the command line, you may need to allocate more memory
for example when synchronizing massive number of fles. If you want to allocate more
memory to DirSyncPro, use the following command to run DirSync Pro with 512MB (adjust
to own will):
java -Xmx512M -jar dirsyncpro.jar
You may choose a larger amount if you need to.
If you start DirSync Pro through the wrapper DirSyncPro.exe under MS Windows, the
wrapper DirSyncPro.exe itself already uses 512MB memory.

4 Frequently Asked Questions (FAQ)
Please visit www.dirsyncpro.org/faq.html for a recent list of FAQ.
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